
 
 
 
 

Instructions to authors for the South African Journal of Animal Science 
(Revised:  December, 2008 

Editorial policy 
 The South African Society for Animal Science (SASAS) welcomes the submission of manuscripts 

from members of the South African Society for Animal Science and from scientists in Africa and abroad 
on all matters germane to the science of animal production for publication in the South African Journal 
of Animal Science (SAJAS). The scope of the journal includes reports of research dealing with farm 
livestock species (cattle, sheep, goats, pigs and poultry), as well as pertinent aspects of research on 
aquatic and wildlife species. The main disciplines covered are nutrition, genetics, physiology and 
production aspects of animal products. Papers dealing with sociological aspects of well-defined livestock 
production systems are invited, providing they are scientific by nature and have been carried out in a 
systematic way. Papers dealing with routine, repetitive testing or economic evaluation of specific 
products, feeds or cultivars, case studies or matters dealing with agricultural extension or consumer 
issues are discouraged unless the results so derived are used to develop or elaborate scientific concepts in 
the field of animal science. Papers that form part of a series are discouraged: this includes different 
aspects of data derived from one particular experiment, or cases in which the analytical techniques, 
animals or experimental procedures are common to all papers. Where authors have valid reasons for 
separation of reports into two manuscripts, these must be submitted simultaneously; delayed or staggered 
submissions will be automatically rejected. In all cases, reports should represent original contributions to 
current scientific knowledge of the principles or the application of principles governing the functioning 
of animals, production aspects of their products and their relationship to the social or physical 
environment. 

 
Publication fee per article published (2009) 
 

SASAS member one of the authors:  R 330.00 (US$ equivalent) (SASAS members may apply for 
exemption of the publication fee); 
Non-members, RSA and SADC: R 650.00  (US$ equivalent);  
Non members, rest of Africa and overseas: US$ 150.00.   
 
This will be levied upon acceptance of manuscript.  
 
No reprints are supplied.   
 

Revising / editing language of manuscript  
Can be arranged at a fee of US$ 100.00. 

 
Types of articles 
All submissions will be subjected to the peer-review process. 

  
Research articles 
Contributions should be based on original unpublished experimental data that have been analysed 
using statistical methods. Multi-part manuscripts derived from a common experiment will not be 
considered unless submitted simultaneously.     
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Short communications 
Results from a limited investigation, work still in progress and new techniques can be submitted as 
a short communication. It should not exceed five printed pages. (See Instructions below). 
Proceedings of Congresses, Conferences or Symposia 
Proceedings of presentations delivered at congresses of the South African Society for Animal 
Science, international conferences held under the auspices of SASAS or other symposia of 
regional branches or interest groups of the Society can be published as separate “Conference 
proceedings” issues of the journal. Contributions will be subjected to the same peer reviewing as 
required for SAJAS, and a publication fee will be charged (to be negotiated). Organisers of such 
events should contact the editor-in-chief to ensure that peer-review procedures and formatting of 
abstracts are compliant with those of the journal. 
 
Reviews 
Reviews should have as their main aim the synthesis or application of new principles, hypotheses 
or future research directions from re-interpretation and scrutiny of existing published scientific 
data. It is normal practice for authors to include some of their own new but previously unpublished 
data in support of the concept that is synthesised. Syntheses and applications from technical 
reports, surveys and other unpublished but scientifically justifiable sources of information can also 
be used in support. Reviews aimed at distilling existing published information into a form that will 
contribute to a clearer understanding of, or more widespread application of research findings by 
generalist extension officers and non-scientists are also welcomed. Reviews are normally solicited 
by the editor-in-chief, but suggestions for topics or authors are welcomed. Reviews are subjected 
to the same peer-review process as is applied to all other submissions. 

  
Electronic publication 

The South African Journal of Animal Science is published electronically via the Internet, and can 
be accessed from the following address: http://www.sasas.co.za/publications or through 
http://www.sasas.co.za 
 
One volume will be published per year, consisting of at least three issues, published at 
approximately 3- to 4-month intervals. Articles will, however, be placed on the Internet as soon as 
the copy-ready version has been approved by the submitting author. Urgent alterations can still be 
made before the hard copy is published.  

 
Copyright 
 
In submitting the corrected version of the manuscript (final version corrected according to reviewers 
comments) for publication in the South African Journal of Animal Science, the authors automatically 
grant and assign all rights protected by copyright laws in the Republic of South Africa and all foreign 
countries, including subsidiary rights, exclusively to the South African Society for Animal Science. The 
unauthorised transfer of PDF files of articles placed on the website of the South African Journal of 
Animal Science to any other website, or any alteration of the original PDF file shall be deemed an 
infringement of copyright. Permission to use or republish material contained in the South African Journal 
of Animal Science must be obtained from the South African Society for Animal Science via the editor-
in-chief of the journal.  
 
Submission and the review process 
 
The data upon which all types of manuscripts are based should be original (except review articles), 
should not have been published previously in a peer-reviewed scientific journal, and should not be under 
consideration for publication elsewhere. Submission of a manuscript is understood to imply that these 
conditions have been met.  The context and/or detail of the new findings must be sufficiently different to 
merit addition to the matrix of knowledge through publication. 

 

http://www.sasas.co.za/sajas.asp
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Submission also implies that all authors have approved the submission and are in agreement with its 
content.  
If figures, tables or parts of other copyright material not owned by the authors are included in articles 
submitted for publication in the journal, it is the sole responsibility of the authors to obtain permission to 
republish such items. 
 
A sub-editor with the assistance of reviewers will be requested to review the manuscript and make a 
recommendation to the editor-in-chief.  
 
Authors may suggest a list of experts whom they consider especially suitable to referee their paper, 
especially if the subject is highly specialized. 
 
The editor-in-chief will advise the corresponding author on the outcome of the review based on the 
recommendation of the sub-editor.  
 
Resubmitted manuscripts will follow the same process of evaluation as the first submission. Any 
resubmittal should be accompanied by a summary of the changes made and a brief response to all 
recommendations and criticisms. 
 
NB: Initially a paper is accepted provisionally. The final decision to accept or reject manuscripts for 
publication resides with the editor-in-chief. If the editor-in-chief considers it necessary, the paper may be 
referred to the journal's editorial sub-committee for a final decision regarding acceptance. 
 
Style and Form 
 
Manuscripts will not be admitted to the peer-review process until they are fully compliant with the style 
and format detailed in the instructions to authors. 
 
Authors are requested to adhere strictly to the following directives and consult the most recent editions of 
the journal for issues not specifically mentioned here. The manuscript must be written in English, using 
the UK English spell check. It is up to the authors to make sure there are no typographical errors in the 
manuscript. 
 
Submissions should be typed in MS WORD (or saved as2 doc files) and submitted as e-mail attachments 
to the editor-in-chief at editor@sasas.co.za
 

• The title must be informative and brief (if possible in punchline form to draw attention). The 
initials and name of the author(s), the address of the institution where the work was done must 
follow the title. Superscripts (1,2,3) should be used in cases where authors are from different 
institutions. The superscript # should be appended to the author to whom correspondence should 
be addressed, and indicated as such together with an e-mail address in the line immediately 
following the keywords. The present postal address of authors, if currently different from that of 
the institution, should also be superscripted appropriately and inserted in the lines following the 
abstract. 

  
• An abstract should be included next. It should contain the following: purpose of study, 

experimental treatments, results, preferably in quantitative data, significance of findings and the 
conclusions. This should not exceed 250 words. Significance levels (e.g. P <0.05) should not be 
included in the abstract. 
The abstract is followed by a list of Keywords: - preferably ones not used in the title. 

  
• The contents must be arranged in an orderly way with suitable headings for each subsection. The 

recommended subdivision of contents is as follows: 

 

mailto:editor@sasas.co.z


 4

  
• Introduction: This should include (a) a statement of why the subject under investigation is 

considered to be of importance, (b) a concise indication of the status quo of published 
research in this field and (c) why this article is considered to be an original contribution to 
current scientific knowledge of the principles or the application of principles governing the 
functioning of animals, production aspects of their products and their relationship to the 
social or physical environment. The last sentence of the introduction should contain a 
declaration of the aims of the experiment, i.e. the hypothesis. The introduction should not 
exceed one page in length. 

• Materials and Methods: These should be concise but of sufficient detail to enable the 
experiment to be replicated by an outside party. Statistical methods used must be clearly 
stated. 

• Results and Discussion may be treated separately or under one heading; do not insert sub-
headings. Integrity in reporting requires that no inconsistent data are omitted or fabricated 
data presented. 

• Conclusions: This should consist of (a) a short integration of results that refer directly to the 
stated aims of the experiment and (b) a statement on the practical implications of the results. 
This section should not exceed one short paragraph. Do not summarise the discussion here. 

• Acknowledgements: Do not include titles of persons; use only initials and surnames. 
Acknowledge financial support from the NRF, and include their project GUN number, as 
required by the NRF. 

• Footnotes are not acceptable.  
  
Main text: Font size 11 pt. The settings for the paragraph text should be as follows: format > paragraph 
> indentation: special; first line, and the alignment of all paragraphs is set as ‘justified’ so that there are 
no ragged edges on the right-hand side of the page. 
  

Do not introduce sub-headings into the main heading sections – separate different sections using 
paragraphs. Do not leave open lines between paragraphs. 
  

Tables are numbered consecutively in bold Arabic numerals (e.g. Table 1  note that there is no following 
colon or full stop) and should bear a short, yet adequate descriptive caption (i.e. the caption should 
enable interpretation of the data presented if the table and caption were to be separated from the text).  
Example: inadequate: “Table 1 Feed intake effects”; correct: “Table 1 Mean (± s.e.) voluntary intake 
(g/d) of two diets differing in crude protein content by early-weaned (21 d) piglets”.(Font size: 11 pt).  
Measures of variance (e.g. s.e. or s.d.) included in tables should be clearly defined in the caption as in the 
preceding example. Metric units are to be clearly shown, symbols and abbreviated must be in accordance 
with international procedure. Explanatory notes to table elements are designated by superscripts, and the 
explanation should appear on the lines directly below the table. Differences between table means should 
be designated using superscripts (superscript should follow the mean in the table and not the s.e.) and the 
following conventional explanatory note which should appear on the line directly below the table: “ a,b,c 
Row means with different superscripts differ significantly at P <0.05”. Tables should be centred on the 
page. Authors should pay special attention to the format for tables regarding lines, i.e. no vertical lines 
and horizontal lines before and after the heading and the last row of data only (see recent journal articles 
for examples). Tables should be inserted at the appropriate place in the text (do not append tables at the 
end of the article). Table contents (including table footnotes) should be typed using Times New Roman 
10 point font. 
 
Do not import tables from other packages. Write them in MS WORD! Tables must fit on a single page, 
according to the Page set-up instructions. Large tables will not be accepted. 
  
Illustrations and diagrams.  These should be inserted into the text at the appropriate position. Graphs* 
that have been scanned in are not acceptable. Graphs could be constructed using MS Excel and inserted 
into the text. All lettering and numerals that appear on figures should be set in Times New Roman 10 
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point font. Coloured lines should not be used; sequence differences should be indicated by symbols. 
Point means should, where possible, be accompanied by standard error bars. Tic marks on axes should 
face towards the inside of the graph. Figures should be numbered consecutively in bold Arabic numerals 
(Figure 1). Avoid the use of “shading” in illustrations. 

Place its title underneath the Figure, but not as part of the inserted section. 
Do not “block” the figure with lines surrounding it. 

*If graphs, diagrams, etc. are imported from e.g. MS Excel, copy it and then under "Edit", use "Paste 
Special" and "Picture" to insert in document.  
Ensure that lines, including axes and graphs, are bright. Faint/thin lines tend to fade when hard copies are 
printed. 
  
Terminology, abbreviations and formulae: Use the SI metric system (US Metric Association) 
(http://lamar.colostate.edu/~hillger/correct.htm) for units of measurement and use a decimal point (i.e. do 
not express units in calories, pounds, miles, etc.). Spell out numbers from one to nine; use numerals for 
larger numbers, groups of numbers, fractions or units, e.g. four; 8-16; 4 kg/ha; 42 ewes, 67%. Note the 
spacing in the following text: P <0.05; 5 min. For litres, use the abbreviation L or mL. When reporting 
concentrations of, for instance, the chemical composition of diets, use g/kg and not %; mg/kg and not 
ppm; mg Cu/kg and not mg/kg Cu; do not use the word “content” when specifying a concentration in 
terms of, for instance, g/kg or %.  Use percent mainly to indicate relative changes.  
When abbreviations are used, they must be explained in full the first time the concept is used, also in 
tables and figures. Do not start a sentence with an abbreviation. 
 
Express nutrient concentrations of feeds preferably on a dry matter (DM) basis and indicate the basis 
clearly in the table. 
 
Do not use the word ‘significantly’ where the level of significance is declared: e.g. use ‘Treatment A 
differed (P <0.01) from treatment B’ and not ‘Treatment A differed highly significantly (P <0.01) from 
treatment B’. Where means do not differ significantly, the appropriate level of probability could be stated 
e.g. “---did not differ (P >0.05)”. Note the following syntax “variables differ between treatments” not 
“variables differ among treatments”. For standard error use the abbreviation s.e. and for standard 
deviation, use s.d.  
 
Ethical  
 
Where applicable animal experimentation must be conducted within standard ethical norms.  A statement 
indicating compliance to that must be included in the Materials and Methods section. 
 
References 
 

• The existing relevant literature must be appropriately and fairly cited; in this respect reference 
efforts are always made to ensure that reference is made to the first report of a finding rather than 
a later elaboration.  

 
References appearing in the text 
• Cite references by name and date in parentheses. In the case of two authors, use an ampersand 

(&) and not “and”. The abbreviation “et al.” must be used in all cases where more than two 
authors are quoted. Personal communications and unpublished work should be cited in the text, 
giving the initials, name and date; they should not appear in the list of references. All other 
references in the text should be listed alphabetically by first authors’ surnames at the end of the 
paper under the heading, “References”. Multiple references within parentheses in the text should 
be cited in chronological order. Examples: 

• Apart from the work of Chevallerie & Smith (1971), Veary (1991) and Lewis et al. 
(1997), little data…….. 

 

http://lamar.colostate.edu/~hillger/correct.htm
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• and has been shown to increase the pH (Chevallerie & Smith, 1971; Veary, 1991; Lewis 
et al., 1997). (note , after et al. not in italics). 

• Do not put “Reference (1991, cited by Lewis et al., 1997)” in text, but in list of 
references, viz. Reference, A.B., 1991. Full or available title. Journal name volume and 
pages (Cited by Lewis et al., 1997).  (See references of Scott and Tainton in list below). 

• Personal communications:  According to Brightguy (2005, A.B. Brightguy, Pers. 
Comm., Centre of Wisdom, P.O. Box 100, Pretoria, 0001) – Enough details so that 
person can be contacted. 

  
References appearing in the list, “References”, at the end of the article: 
• Journal names must be abbreviated according to the World List of Scientific Periodicals. Authors 

should pay special attention to the syntax used in the reference list and check that references in 
the text correspond completely and exactly with those given in the reference list.  

• In all cases, a reference must provide sufficient information to enable the reader to obtain a copy 
of it; references to unpublished congress presentations are NOT acceptable. 

• Reference to internet articles is permissible. Supply full traceable reference in list. 
• NB: It is the FULL responsibility of the authors to cross-check references in the text of the 

article with those in the list of references.   
 
• Examples of references: (Hanging indent 1 cm) 

  
AOAC, 1984. Official methods of analysis (14th ed.). Association of Official Analytical Chemists, 

Inc., Arlington, Virginia, USA. 
Hoffman, L.C. & Ferreira, A.V., 2000. pH decline of the M. longissimus thoracis of night-cropped 

grey duiker (Sylvicapra grimmia). S. Afr. J. Anim. Sci. 30, 16-17. 
Lawrie, R.A., 1998. Lawrie’s Meat Science. 6th ed.  Woodhead Publ. Ltd. Cambridge, England. 

336 pp. 
NRC, 1984. Nutrient Requirements of Beef Cattle (6th ed.). National Academy Press, Washington 

D.C., USA. 
Read, M.V.P., 1984. Animal performance from natural pastures and the effects of phosphorus 

supplementation. MSc (Agric) thesis, University of Stellenbosch, South Africa. 
SAS, 1985. Statistical Analysis Systems user's guide (5th ed.). SAS Institute Inc., Raleigh, North 

Carolina, USA. 
Sutton, J.D., 1976. Energy supply from the digestive tract of cattle.  In: Principles of Cattle 

Production. Eds.  Swan, H. & Broster, W.H., Butterworths, London.  pp. 12-22. 
Scott, J.D., 1947. Veld management in South Africa. Bull. Dept. Agric. S. Afr. No. 28. (cited by 

Tainton, 1999).  
Tainton, N.M., 1999. The ecology of the main grazing lands of South Africa. In: Veld 

Management in South Africa. Ed. Tainton, N.M., University of Natal Press, 
Pietermaritzburg, South Africa. pp. 48. 

 
 

• Articles in foreign languages: 
 
Yalçın, H., 1997. Central North Anatolian zeolite occurrences related to Eocene submarine 

volcanism in Turkey. Bull. Eng. Fac. Cumhuriyet Univ. Serie A-Earth Sci. 14, 43-56 (in 
Turkish, English abstract). 

Türkoğlu, M., Arda, M., Yetişir, R., Sarıca, M. & Erensayın, C., 1997. Broiler production. In: 
Poultry Science, Otak Form-Ofset, Samsun. pp.167-185 (in Turkish). 

 
Style and format of Short Communications 
 
A short communication should be a maximum of five pages. It contains a very brief abstract followed by 
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a brief introduction, text including tables and figures and a brief conclusion followed by references. No 
subheadings are to be included except for the Abstract. Format, tables and figures must conform to the 
conventions of the Journal. 
 

SUMMARY OF FORMAT 
Submissions will not be accepted unless formatted as follows: 
  
Page size: A4 
Line numbering OFF 
Page numbering ON - position: top right, font: Times New Roman 10 point 
Line spacing: single 
  
File > Page Setup> Margins 
Top: 3 cm 
Bottom: 2.5 cm 
Left: 2 cm 
Right: 2 cm 
Gutter: 0 cm 
Header: 1 cm 
Footer: 1.4 cm 
  
File > Page Setup>Paper size 
210 X 297 mm (A4) 
  
  
Insert > Page numbers 
Position: Top of page (header) 
Alignment: right 
  
For main text (excluding headings) use the following: 
Format > Font >  
Font: Times New Roman 
Style: Regular 
Size: 11 pt 
  
Format > Paragraph 
First line of paragraph: first line indent: 1 cm 
Line Spacing: Single 
References: hanging indent: 1 cm 
 
Symbols: Whenever possible, use “normal text”. 
  

Title: Font size: 14 pt, bold, centred (no full stop) 
 14 pt 

Authors# and Co-author: Font size: 12 pt, bold, centred 
Affiliations, including country: Font size: 10 pt, centred 

10 pt 
10 pt 

Headings (e.g. Abstract, Materials): Font size: 12 pt, bold  
Keywords: Font size: 11 pt,  
# Corresponding author. E-mail: editor@sasas.co.za   Font size: 10 pt 
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